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Safety Notices

CAUTION
A CAUTION notice denotes a hazard. It 
calls attention to an operating proce-
dure, practice, or the like that, if not 
correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not pro-
ceed beyond a CAUTION notice until 
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understood and met. 

WARNING
A WARNING notice denotes a hazard. 
It calls attention to an operating pro-
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could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.
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Safety Summary
The following general safety precautions must be observed during all phases of operation of this 
instrument. Failure to comply with these precautions or with specific warnings or operating 
instructions in the product manuals violates safety standards of design, manufacture, and intended 
use of the instrument. Keysight Technologies assumes no liability for the customer's failure to comply 
with these requirements. Product manuals are provided with your instrument on CD-ROM and/or in 
printed form. Printed manuals are an option for many products. Manuals may also be available on 
the Web. Go to www.keysight.com and type in your product number in the Search field at the top of 
the page.

General Do not use this product in any manner not specified by the manufacturer. The protective features of 
this product may be impaired if it is used in a manner not specified in the operation instructions.

Before Applying
Power

Verify that all safety precautions are taken. Make all connections to the unit before applying power. 
Note the instrument's external markings described in “Safety Symbols”.

Ground the
Instrument

If your product is provided with a grounding type power plug, the instrument chassis and cover must 
be connected to an electrical ground to minimize shock hazard. The ground pin must be firmly 
connected to an electrical ground (safety ground) terminal at the power outlet. Any interruption of 
the protective (grounding) conductor or disconnection of the protective earth terminal will cause a 
potential shock hazard that could result in personal injury.

Fuses See the user's guide or operator's manual for information about line-fuse replacement. Some 
instruments contain an internal fuse, which is not user accessible.

Do Not Operate in
an Explosive
Atmosphere

Do not operate the instrument in the presence of flammable gases or fumes.

Do Not Remove the
Instrument Cover

Only qualified, service-trained personnel who are aware of the hazards involved should remove 
instrument covers. Always disconnect the power cable and any external circuits before removing the 
instrument cover.

Cleaning Clean the outside of the instrument with a soft, lint-free, slightly dampened cloth. Do not use 
detergent or chemical solvents.

Do Not Modify the
Instrument

Do not install substitute parts or perform any unauthorized modification to the product. Return the 
product to an Keysight Sales and Service Office for service and repair to ensure that safety features 
are maintained.

In Case of Damage Instruments that appear damaged or defective should be made inoperative and secured against 
unintended operation until they can be repaired by qualified service personnel.

CAUTION
A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, 
or the like that, if not correctly performed or adhered to, could result in damage to the 
product or loss of important data. Do not proceed beyond a CAUTION notice until the 
indicated conditions are fully understood and met.

WARNING
A WARNING notice denotes a hazard. It calls attention to an operating procedure, 
practice, or the like that, if not correctly performed or adhered to, could result in 
personal injury or death. Do not proceed beyond a WARNING notice until the indicated 
conditions are fully understood and met.

http://www.keysight.com
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Safety Symbols

Table 1  Safety Symbol

Symbol Description

Direct current

Alternating current

Both direct and alternating current

Three phase alternating current

Three phase alternating current

Earth ground terminal

Protective earth ground terminal

Frame or chassis ground terminal

Terminal is at earth potential

Equipotentiality

N Neutral conductor on permanently 
installed equipment

L Line conductor on permanently installed 
equipment

On (mains supply)

Off (mains supply)

Standby (mains supply). The instrument is 
not completely disconnected from the 
mains supply when the power switch is in 
the standby position

In position of a bi-stable push switch
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Out position of a bi-stable push switch

Equipment protected throughout by 
DOUBLE INSULATION or REINFORCED 
INSULATION

Caution, refer to accompanying 
documentation

Caution, risk of electric shock

Do not apply around or remove from 
HAZARDOUS LIVE conductors

Application around and removal from 
HAZARDOUS LIVE conductors is 
permitted

Caution, hot surface

Ionizing radiation

CAT I IEC Measurement Category I

CAT II Measurement Category II

CAT III Measurement Category III

CAT IV Measurement Category IV

Symbol Description
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Compliance and Environmental Information

Table 2  Compliance and Environmental Information

Safety Symbol Description

CSA is the Canadian certification mark to demonstrate compliance with the Safety 
requirements.

The C-tick mark is a registered trademark of the Spectrum Management
Agency of Australia. This signifies compliance with the Australia EMC
Framework regulations under the terms of the Radio Communication Act
of 1992.

CE compliance marking to the EU Safety and EMC Directives.
ISM GRP-1A classification according to the international EMC standard.
ICES/NMB-001 compliance marking to the Canadian EMC standard.
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The Real-Time Compliance tool evaluates DDR/LPDDR data in real-time to detect and report 
violations to compliance limits specified in DDR/LPDDR specifications. Unlike the DDR Post Process 
Compliance tool that evaluates the data captured in a trace for violations, this tool evaluates 
real-time data captured by an Keysight logic analyzer module. 

The Real-Time Compliance tool can evaluate DDR, DDR2, DDR3, DDR4, DDR5, LPDDR, LPDDR2, 
LPDDR3, LPDDR4X, and LPDDR5 target systems for compliance violations.

Besides providing predefined compliance tests for DDR/LPDDR, the tool also allows you to create 
and run user-defined tests for DDR/LPDDR or any other general-purpose tests. 
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How the Real-Time Compliance Tool Works

The tool allows you to load, configure, and run a set of compliance tests on the real-time data being 
captured from a DDR/LPDDR target system. 

You can either run compliance tests from the set of predefined tests available with the tool or create 
and run your own compliance tests to suit your specific requirements. 

Each predefined compliance test has an associated specification parameter based on which one or 
more trigger condition(s) are defined. For example, the test displayed in the screen below has a 
trigger condition based on the tRASmin specification parameter. 

When the test is run, the tool checks the real-time data for compliance limit violations as per the 
trigger condition(s). On encountering a violation, the trigger condition is met and the tool reports it 
as a violation. For DDR4, DDR5, or LPDDR5 tests, the tool also reports the compliance limit pass 
events found before a violation was encountered.

Besides reporting the violation, the tool also performs any additional actions (such as saving the 
violation trace) that you have configured it to perform in the event of a violation.

In case the tool does not detect any violations within the time that you specified for the execution of 
the test, the tool stops the current test and starts running the next test in the sequence. If all tests 
have already been run, then the tool stops.

The tool uses the trigger specifications specified for the Logic Analyzer module to run tests on valid 
captured data. The trigger specifications are already defined for the predefined tests that ship with 
the tool. For user-defined tests, you need to define the trigger specifications.

NOTE
There are some tests that cannot be run real-time. For such tests, you need to 
use the DDR Post Process Compliance tool. 
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Introduction 1

Flow of Steps

The following screen displays a general sequential flow of steps for using the Real-Time Compliance 
tool.

These steps are described in detail in the topics that follow.
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2 Before You Start

Before you start using the tool, ensure that you have:

1 Installed the Keysight Logic and Protocol Analyzer software version 5.50 or higher. The 
Real-Time Compliance tool works with this software.

2 Installed the Real-Time Compliance tool’s software and enabled its license. The Real-Time 
Compliance tool is a part of the B4661A Memory Analysis Software Tools package. Therefore, the 
tool is available only after you install the Keysight B4661A Memory Analysis Software Tools 
package.

After installation, you must enable the software license by following the instructions on your 
Entitlement Certificate. 

3 Accurately set up the hardware and software of the Keysight logic analyzer to capture the 
required data of the DDR-type bus being monitored. Doing so ensures that you have valid data on 
which to run compliance tests to detect violations. 

Refer to the Keysight Logic and Protocol Analyzer Online Help to know how to set up the 
Keysight logic analyzer to capture the required data. 

Refer to the DDR Setup Assistant Online Help to know how to set up your logic analyzer properly 
for DDR/LPDDR data capture and analysis.

NOTE
You can install the Keysight Logic and Protocol Analyzer application and Keysight 
B4622B DDR2/3 Protocol Compliance and Analysis Tool package from the Keysight web 
site at: www.keysight.com/find/lpa-sw-download.

www.keysight.com/find/lpa-sw-download
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3 Starting the Real-Time 
Compliance Tool

The Real-Time Compliance tool is accessible from the Keysight Logic and Protocol Analyzer GUI. 

To start the Real-Time Compliance tool

1 Select Tools > External Applications > Real-Time Compliance Tool from the Keysight Logic and 
Protocol Analyzer GUI menubar.

The Real-Time Compliance Tool is displayed.



3 Starting the Real-Time Compliance Tool

16 Real-Time Compliance Tool User Guide

At times, you may get the following error message when trying to launch the Real-Time Compliance 
tool.

This error message indicates that the B4661A license needed for this tool is not currently available on 
the system. To access the tool, you need to purchase and install the B4661A-3 license.
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4 Loading, Configuring, and 
Selecting Compliance Tests

Test Groups, Tests, and Specification Parameters  /  18
To load a test group  /  19
To select compliance tests  /  21
To set or edit specification parameters  /  23

Manually Overriding the Default Value of a Parameter  /  23

Applying a Parameter Value XML File  /  24

Setting Parameter Values Automatically as per your System’s Characteristics  /  26
Specifying Test Execution Time  /  29
Configuring the Tool’s Run Options  /  31
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Test Groups, Tests, and Specification Parameters

Compliance tests are grouped as test groups and stored in XML files. For instance, the DDR3 tests 
are grouped and stored in the DDR3Tests.xml file.

When you install the Real-Time Compliance tool, a set of predefined test groups (XML files) are 
installed at the following location.

C:\Program Files (x86)\Keysight Technologies\Logic Analyzer\ExternalApps\
RealTimeComplianceTool\Test Group Files

You first need to load a required test group XML file, then select the tests that you want to run from 
that test group, and if required edit the specification parameters of tests.

The following screen displays a DDR4 test group XML file and the tests that it contains along with the 
associated specification parameter for each test.
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Loading, Configuring, and Selecting Compliance Tests 4

To load a test group

1 Click the Setup tab in the Real-Time Compliance tool.

2 From the Select logic analyzer module listbox, select the logic analyzer module that you are using 
for capturing DDR data. If more than one module exists in the setup, you need to select which 
one to use for running the compliance tests. If only one module exists, it will be selected 
automatically.

3 Click the Load Test Group... button.

4 Browse and select a predefined or a user-defined test group XML file and click Open. 

On loading the test group XML file, all the tests included in the group are displayed in the Real-Time 
Compliance tool. 
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Selecting Test Group Options for DDR Test Groups

If you are loading a DDR2, 3, 4, or 5 test group, you are presented with a few options while loading 
this test group. These options allow you to adjust the tests according to your system. You can set 
these options either at the time of loading the test group or later by clicking the Options button in the 
Setup tab.

These options vary based on the DDR technology to which the test group belongs. For instance, the 
Refresh Options is displayed for a DDR2, 3, 4, or 5 test group and allow you to select whether or not 
the SUT has constant refresh rate. Accordingly, the REFRESH to REFRESH test is added or removed 
from the list of tests to run.

The Rank Selection Mode option is displayed only for a DDR4 test group. You use this set of options to 
select the appropriate rank addressing mode based on the rank addressing being used for your 
DDR4 RDIMM device. In the Standard DDR4 rank addressing, there is one CS# (chip select) line for 
each rank. In the 3DS rank addressing, there is only one CS# line for all the ranks. Therefore, the 
logical value of the C (Chip ID) bits is used to identify the rank being addressed in the decode. The 
number of Chip ID bits to be used for rank identification is as per the 3DS specifications. From the 
available 3DS rank addressing options (2-high, 4-high, or 8-high), select the appropriate option 
based on whether your 3DS device has two, four, or eight logical ranks. The tests displayed in the 
Select Tests to Run section vary based on the rank addressing mode that you select. For instance, 
the tests for same or different logical ranks are displayed if you select one of the 3DS rank addressing 
mode.
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To select compliance tests 

You can choose to run all or some of the tests included in the loaded test group. By default, none of 
the tests in a group are selected. 

By selecting the checkbox displayed with the test group name, all the tests in that group are selected 
to run. To include specific tests for execution, select the checkbox displayed with each of the 
individual test you want to run.

Expanding a test allows you to further narrow down the test execution to selective Chip selects and 
banks. For example, in the screen below, the first test is run only for Bank 0-2 of Chip Select 0. 

If you want to run all tests in a test group for a particular chip select, then instead of expanding each 
test and selecting the specific chip select checkbox, you can use the Test Selection Shortcuts option. 
Clicking this option displays options to select all tests for a particular chip select in a single click. 
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To set or edit specification parameters

Each compliance test has a specification parameter associated with it. The default value of each 
specification parameter is already set in the Real-Time Compliance tool. If required, you can override 
this default value and set a new value suitable to your specific requirements such as bus speed and 
bus type. The Real-Time Compliance tool will then use these new values to perform compliance 
testing and to arrive at pass/fail and/or margin information for each test.

You can set the value of specification parameters in the following three ways:

These three methods are described below.

Manually Overriding the Default Value of a Parameter

1 In the Real-Time Compliance tool, load the required test group.

2 Click the Edit Parameters... button displayed in the Setup tab.

The Edit Test Parameters dialog box is displayed with the list of all the specification parameters 
applicable for the test group.

Method Available for...

Manually override the default value of individual specification parameters. All test groups

Apply a Parameter Value XML file to change the value of all the specification parameters in a test group 
to the values appropriate for a particular bus speed. A number of predefined Parameter Value XML files 
are installed with the Real-Time Compliance tool for the most common bus speeds for all DDR bus 
types. These files are installed at:
C:\Program Files\Keysight Technologies\Logic Analyzer\ExternalApps\RealTimeComplianceTool\Pa-
rameter Value Files
Applying a Parameter Value file quickly changes all the parameter values to match the values applica-
ble for a particular bus speed.

All test groups

Set specification parameter values automatically based on your system’s characteristics that you 
specified in the Real-Time Compliance tool. 

DDR4, DDR5, and LPDDR5 
test groups only
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3 Click the down-arrow button displayed with a specification parameter to view its current value, 
get more information about it, and view options to modify its value.

In the screen below, the details and default value of the tRTP parameter is displayed.

4 Select the Manually override value of <parameter> checkbox.

5 Specify a desired value of the parameter in the Enter value for <parameter> (in LA states) field.

6 Click OK.

Applying a Parameter Value XML File

1 In the Real-Time Compliance tool, load the required test group.

2 Click the Edit Parameters... button displayed in the Setup tab.

The Edit Test Parameters dialog box is displayed with the list of all the specification parameters 
applicable for the test group.
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Loading, Configuring, and Selecting Compliance Tests 4

3 Click the Apply Parameter Values File... button.

A list of predefined Parameter Value XML files provided with the tool is displayed. 

4 Select a Parameter Value XML file that matches your bus speed type and click Open.

5 Click OK to acknowledge the success message.

All the parameter values are automatically changed to match the bus speed for which the Parameter 
Value file is selected.

You can view the most recent parameter file that you applied to the loaded test group in the Edit Test 
Parameters dialog box.
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Setting Parameter Values Automatically as per your System’s Characteristics

1 In the Real-Time Compliance tool, load the required test group.

2 Click the Set Limits From System Parameters... button displayed in the Setup tab.

The Specify System Values dialog box is displayed.

3 Specify the values matching your system’s characteristics and then click OK. 

All the specification parameter values are then automatically set as per the system values that 
you specified in the Specify System Values dialog box. You can view the changed specification 
parameter values in the Edit Test Parameters dialog,

Example

The following is an example of how the tRFC specification parameter value is changed 
automatically based on the user-specified system characteristics. 

In screen 1, the default value of the tRFC parameter is set to 280 (1X-Normal Refresh Mode). 

In screen 2, the Refresh mode system value is changed to 2X (Fine Granularity Refresh Mode) to 
match the system characteristics. In screen 3, the value of the tRFC parameter is automatically 
changed to 128 (in DDR clocks) to match the changed Refresh mode system characteristic. 

NOTE
The Set Limits From System Parameters... button is displayed only if you 
load a DDR4, 5, or LPDDR5 test group.
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Figure 1 Screen 1 showing the default value of the tRFC parameter 

Figure 2 Screen 2 showing the Refresh mode system value changed to 2X 
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Figure 3 Screen 3 showing the changed tRFC parameter value to match the changed 
Refresh mode system value 
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Specifying Test Execution Time

You can specify the time for which you want the tool to execute a selected test. The tool then 
automatically stops the test execution after the expiry of the specified time and continues running 
the next test in the sequence. 

Alternatively, you can also configure the tool to run the selected test(s) indefinitely in a loop until you 
manually cancel the test execution. You do this by selecting the Loop through selected tests until user 
cancellation checkbox at the bottom of the Setup tab.

To specify test execution time

1 Click the Setup tab in the tool.

2 Load the test group for which you want to specify the execution time.

3 Click the Specify Time to Run Each Test... button.

The Specify Time to Run Each Test dialog box is displayed.

4 In the Default Test Time section, specify the execution time in hours, minutes, and seconds for 
which you want a test to be executed. This time is applicable for each test in the loaded test 
group.
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5 To run different tests for different length of time, you can override the default execution time for 
tests. To override the default execution time for a test:

a Click the down-arrow button displayed with the test in the Override Default Time for Each Test 
section.

b Select the Override the default time for this test checkbox.

c Specify the execution time for the test.

6 Click Close.

Based on the time that you specify, the tool automatically calculates estimated total time for the 
execution of all the tests that you selected in the Setup tab. 

NOTE
The actual execution time for tests can be less or more than the estimated total time 
calculated by the tool based on factors such as:

Saving a violation trace during a test run can increase the execution time for the test if the 
violation is found very close to the end of a test's run time.

If the maximum number of violations are detected for a test, the tool stops running that 
test even if there is time remaining for the test execution. The test then runs for a shorter 
amount of time than the specified time.
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Configuring the Tool’s Run Options

After loading and configuring the compliance tests that you want to run, you can configure the 
Real-Time Compliance tool’s run options for the actions to be performed on detecting a compliance 
violation. You use the Run Options tab of the tool to configure these options.

To configure run options for the tool

1 Click the Run Options tab in the tool.

2 From the When a violation is found listbox, select the action to be performed on detecting a 
violation. Besides reporting a compliance violation in the Run/Results tab, the Real-Time 
Compliance tool can perform one of the following actions on detecting a compliance violation:

• Stop running the current as well as remaining tests.

• Save the violation trace in a Logic Analyzer configuration (.ala) file with a user-specified name 
and location and continue running tests. Each time a violation is detected, the tool saves the 
violation trace in a new file with the same base file name that you specified and appends _<n> 
to the base file name to avoid overwriting the previously saved trace files. <n> represents the 
violation number. For instance, if you specified the base file name as 
DDR3ComplianceViolation, then the tool saves the first violation trace as 
DDR3ComplianceViolation_0.ala and the next violation trace as 
DDR3ComplianceViolation_1.ala. 

• Continue running tests without saving the captured data in a trace.

3 Specify the maximum number of violations that the tool can report for a test. The default value is 
10. When the number of violations reported for a test reaches the maximum number allowed per 
test, the tool stops the execution of that test and continues with running the next test in the 
sequence. This allows you to control and limit the number of violation traces to be saved when a 
violation is found repeatedly. 

After reporting the maximum number of violations for a test, the test execution stops even if there 
is time remaining for the execution of the test.

4 In the Save files in directory field, specify the complete path where you want the tool to save 
violation traces. This field is enabled only when you select the Save trace and continue running 
option from the When a violation is found listbox.

5 In the Base filename field, specify the base file name with which you want the tool to save violation 
traces as logic analyzer configuration (.ala) files. For a violation trace, the tool appends a violation 
number (starting with 0) to this base file name to save traces with unique file names.
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This field is enabled only when you select the Save trace and continue running option from the When 
a violation is found listbox.
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Running the Selected Tests

You use the Run/Results tab of the Real-Time Compliance tool to run the selected tests as per the 
options configured in the tool setup.

To run the selected tests

1 Click the Run/Results tab of the tool.

2 Click the Run Selected Tests button.

The tool starts sequential execution of selected tests on the real-time data captured by logic 
analyzer module. 
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Running the Selected Tests and Viewing Results 5

Stopping the Tool

Once started, the tool executes the selected tests for the time that you specified for test 
execution and stops automatically after all the tests have been executed for the specified time. 
To cancel the test run and stop the tool manually, click the Cancel button in the Run/Results tab.
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Viewing Results

When you start running tests, the tool keeps reporting the test results in the Run/Results tab. 

Besides reporting compliance violations, the tool also reports a count of pass events for each test to 
help you assess the extent of test coverage.

Contents of Results Displayed for a Test

• Start and end time of the test

• Chip select, bank group, and bank for which the test was executed.

• Compliance limit violation(s) encountered for the test.

• The following additional information is displayed in test results for DDR4, DDR5, and LPDDR5 
tests.

• With each violation, the tool also lists the count of compliance limit pass events found before 
encountering the violation.

• Pass events counter for the test. In case the tool does not encounter any compliance limit 
violation for a test, then it reports the total number of pass events found for the test.  

Sample Test Results (with pass events) for DDR4 Tests

NOTE
The count of pass events is displayed only when you are running tests for 
DDR4, DDR5, or LPDDR5 memory types.
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Sample Test Results (without pass events) for DDR3 Tests

Viewing a Violation Trace

If you have configured the tool to save violation traces, you can open the violation trace .ala file in the 
Logic and Protocol Analyzer GUI and view the captured data with violation(s) in various viewers.

Exporting Test Results to a CSV file

You can export the test results displayed in the Run/Results tab to a CSV (Comma Separated Value) 
file. 

To export test results

1 Click File > Export Results... in the Real-Time Compliance tool.

2 Browse and specify the path and name for the CSV file in which you want to export results.

3 Click Save.

Format of a CSV File

The format in which tests results are exported is displayed in the first line of the exported CSV file.
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6 Saving the Real-Time 
Compliance Tool Setup

You can save the Real-Time Compliance tool’s setup in a XML file. Saving the setup saves the 
settings that you configured in Setup and Run Options tabs of the tool as well as the test results 
displayed in the Run/Results tab. Once saved, the test environment is available for future use by 
loading the saved XML file.

To save tool’s setup

1 Click File > Save Setup... in the Real-Time Compliance tool.

2 Browse to the location where you want to save the setup XML file.

3 Specify a name for the XML file and click Save.

All the current settings displayed in the tool are saved in the specified XML file.

To load a previously saved setup 

1 Click File > Load Setup... in the Real-Time Compliance tool.

2 Browse to the location of the XML file in which the required setup is saved.

3 Select the XML file and click Open.

All the settings and any test results saved in the selected XML file are displayed in the tool.
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7 Creating Your Own 
Compliance Tests/Test 
Groups

Besides running the compliance tests provided with the tool, you can create your own specific tests 
and run these tests using the tool.

You can:

• create a new test group XML file and create new test(s) within this test group.

• create new test(s) and add these to an existing test group XML file

To create user-defined tests and test groups

1 Click Custom > User-Defined Test Utility... in the Real-Time Compliance tool.

The User-Defined Test Creator Utility is displayed.

2 In the Location for New Test section, select where you want to create the test - in a new or an 
existing test group XML file.
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3 If you selected to create the test in a new test group file, specify the details of this new XML file. 
These test group details will be displayed in the tool when you later load the test group.

4 If you selected to create the test in an existing test group file, browse and select the XML file.

5 In the Test Information section, specify the name and description for the new test. The test will be 
displayed with this name in the tool when you later load it.

6 Select the source from which trigger specifications will be taken for the new test to trigger the 
Logic Analyzer module.

• Select Get current trigger specification from Keysight Logic Analyzer to use the trigger specifications 
specified for the logic analyzer module currently used for capturing data on which tests are 
run.

• Select Get trigger specification from XML trigger file to use the trigger specifications specified in a 
previously saved Logic Analyzer trigger specification XML file. To know how to save a trigger 
sequence setup of a logic analyzer module in a XML trigger file, refer to the topic “To store a 
trigger” in the Logic and Protocol Analyzer Online Help.

7 Specify the name and location of the XML trigger specification file if you selected the Get trigger 
specification from XML trigger file option.

8 Click Create Test.

9 Click OK to acknowledge the test creation.

The tool creates the new test in the specified XML file. If required, you can further customize it by 
editing the XML file directly.

Once created, you can load and run the new test in the tool in the same way as any other predefined 
test.
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8 Troubleshooting Error 
Messages

Problem: Trigger specifications for a test not understood by Logic Analyzer

Description

While running a compliance test in the Real-Time Compliance tool, the Run/Results tab may display 
an error message that the trigger specification for the test was not understood by Logic Analyzer. 

Causes and Solution

The trigger specifications specified in the test's XML file are used to set the trigger specifications for 
the Logic Analyzer module based on which the tool runs the test on captured data. At times, the 
trigger specification from the XML file is not understood by Logic Analyzer because of one of the 
following reasons:

• For a predefined test shipped with the tool, the trigger specification is predefined. For such a test, 
the cause of error can be:

• The test refers to a bus or a signal that does not exist in your current setup. In such a situation, 
verify that the test is appropriate for your current setup and probing solution. The most 
common occurrences of this problem is when either the CS# or CKE busses are not wide 
enough. For instance, you may run a test for chip select 3 when there are only 2 chip select or 
clock enable signals resulting in an error displayed for chip Select 3.

• An incorrect value provided while manually overriding the default value of a test parameter in 
the Edit Test Parameters dialog. For instance, a non-numeric value provided for a parameter 
that requires a numeric value.

• For a user-defined test, review the trigger specification that you specified for the test in its XML 
file in addition to checking the above-mentioned possible causes.
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